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1) Dasher Pro™ and Animation Director™ overviews 
 
Many people have asked the question about the differences 
between Animation Director™ and Dasher Pro™.  The simplest 
answer is that Dasher Pro™ only works with grids while 
Animation Director™ will let you work with grids as well as let 
you write code in ACL and download your shows to a Monster 
Brain™. 
 
2) Installing the software 
 
Take the provided CD and install the software on your computer 
by executing the following steps: 
 
1. Insert the CD into your CD-ROM drive.  The setup program 
should automatically begin.  If it doesn’t, click on the Start button, 
select Run, and type in D:\setup.exe  Substitute the ‘D’ for the 
letter your computer uses for your CD-ROM drive. 
2. Follow the instructions on the screen.  It is advisable to use the 
suggested defaults when installing the software. 
 
After the software has been installed you shouldn’t need to reboot. 
 
Run the software by clicking the Start button, selecting Programs, 
Animated Lighting, and then the software you wish to use. 
 
Please note the version number on the splash screen (the screen 
that appears when the software is starting) as you will be asked for 
this information when you contact Animated Lighting™ for 
assistance.  This information is also available within the 
application by going to the Help menu and selecting the About 
menu option. 
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3) Help 
 
Before we get started programming, check out the included help 
information by pressing the F1 key.  You should see the following 
window appear: 
 

 
 
Click on the various topics on the on the left to bring up the 
associated information on the right. 
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4) Configuring the software 
 
The first thing a person needs to do after installing the software is 
to set it up.  This is accomplished by clicking on the System button 
on the left side of the screen and then selecting the Setup tab.  
Then select the COM port you will be using on your computer and 
select the subdirectories of where you want the various files you 
will be working with to be stored.  Finally, click the Close button 
to close the window and return you to the main Animation Director 
screen. 
 

 
 
You should only need to do this once unless you change COM 
ports or file locations. 
 
At this point we need to connect the computer to your Animated 
Lighting™ hardware.  You can use a standard 9 pin serial cable to 
go between your computer’s serial port to the DB9 port on the 
Monster Brain™ or you can use serial adapters and cat5 network 
cable to accomplish the same thing. 
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Other connectivity options are available (i.e. you can connect your 
computer directly to devices) but for the sake of simplification we 
are assuming a Monster Brain™ is involved. 
 
After configuring your COM port, select the Version tab at the top 
of the window and then click the ‘Get Version’ button.  The 
Monster Brain™ should return it’s firmware’s version number, 
available memory and auto run flag status.  If this happens then 
you have successfully established communication between the 
computer and the hardware.  If there is a problem getting the 
version information from the Monster Brain, verify that there is 
power to the Monster Brain™ and that the heartbeat LED (Red 
LED) is blinking.   
 
If you aren’t successfully communicating with the hardware please 
refer to our troubleshooting guide located in Appendix B. 
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5) Moving around in the software 
 
You will notice there are different buttons on the left side of your 
screen. 
 

      
 
Clicking the Routines button will take you to screens where you 
can create and edit Startup, Grid, and code routines.  Here is a 
sample screen shot: 
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Clicking the Lights button takes you to a window where you can 
define different properties of your lights, including naming them, 
selecting colors, and grouping them.  You can also use this 
window to your lights to ensure they are working and can update 
the firmware on the LC units you have.  A sample screen shot: 
 

 
 
Clicking the Sounds button takes you to a window where you can 
work with different sound files and your SC-1 Sound Controller 
hardware.  You can also use this window to update the firmware 
on the SC units you have.  Here is a sample screen shot: 
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Clicking the Digital button takes you to a window where you can 
work with different aspects of your DCR hardware.  You can read 
the different inputs, test the various outputs, and update the 
firmware on the DCR units you have.  Once again, a screen shot: 
 

 
 
Clicking the X10 button takes you to a window where you can 
work with different aspects of your X10 hardware.  You can test 
the various outputs.  Here is a sample screen shot: 
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The System screen was where we configured the software to use a 
specific COM port and directories to store your files. 
 
At this point if you aren’t successfully communicating with the 
hardware please refer to our troubleshooting guide located in 
Appendix B. 
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6) Creating a Show 
 
In this section we will take you through the process of creating a 
Show using the Animation Director™ software.  We will define 
different terms and lighting effects as we come across them. 
 
Start a new show by clicking the File menu.  A Show can contain 
multiple routines that include different types of effects and lighting 
patterns. 
 
The first step in creating a new show is telling AD how many light 
controllers or other devices will be connected to the system 
(NOTE: one LC-64 = four LC-16’s).  You can select how many 
LC units you have available by clicking the Lights button  on 
the left side of the screen and then selecting the check boxes next 
to the Light Controller addresses you have.  You will need to set 
different addresses on each controller (refer to Appendix C for a 
table of switch settings and the addresses they represent). 
 
If you are connected to the Monster Brain and Light Controllers 
you can click the ‘Verify Checked Controllers’ or ‘Find All 
Connected Controllers’ buttons to make sure all controllers are 
connected to the system and you can communicate with them. 
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Channels 
 
You can label a channel according to color and location to make it 
easier to reference in the future without having to memorize what 
lights are connected to each channel of your Light Controllers. 
 
Click on the Lights tab at the top of the window.  Next, right-click 
on each channel you wish to work with, select ‘Edit Light Data’ 
and proceed to define the name and color.  It is helpful to use a 
naming convention when labeling the various channels (such as 
tree1.red, tree1.green, etc) so they are easier to recall later. 
 
There is a special feature called ‘Auto Color’ that allows you to 
label the color of the lights if they are connected to your controller 
in a patterned order. 
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Groups 
 
You can group channels by color or location/zone.  This allows 
you to turn on multiple channels using one command. 
 
Click on the Groups tab at the top of the window.  There is an 
Auto-Group function available by right clicking the desired group 
and selecting the ‘Auto-Group’ function.  This function allows you 
to create groups by color and/or location. 
 
You can also create groups by dragging lights from the ‘Lights’ 
box on the right to the desired group in the ‘Groups’ box on the 
left.  You can change the name of the group by right clicking on 
the group and selecting ‘Edit Group Data’. 
 
Whenever you create new groups or modify current groups, you 
must download new group information to the light controllers.  
When downloading new groups you should first clear the previous 
group information. 
 
Up to 120 groups can be created and stored in any light show, 
regardless of the number of Light Controllers. 
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Configuring the Startup Routine 
 
You can modify the Startup Routine so that your show will start 
and stop at specified times of the day and week.  You can also 
have your show start on the occurrence of an event like a digital 
input, analog input or an X10 input.  A digital input can be any 
device that is on or off, like a door matt switch or motion detector.  
An analog input is a variable input that changes its value, like a 
light sensor or pressure sensor.  You can have the show loop 
continuously when the power is on and the Monster Brain™ is 
running by selecting ‘Always’. 
 

 
 
 



 

Copyright© 2003 
Animated Lighting, L.C. 

All Rights Reserved Software Overview - 13 
 

Software 
Overview 

Creating a grid routine 
 
A grid routine is one of the methods used to program the Monster 
Brain™ using a graphical interface.  A grid routine allows you to 
program which channels to turn on and off at different points in 
time.  A new grid routine can be created by selecting the Routines 
menu and then selecting ‘Add New Grid Routine’.  The grid 
routine configuration window is shown below.  You can label the 
routine according to its function or sequence of events when you 
create it or by double clicking the label in the ‘Routines’ box later. 
 
When you create a new grid routine you need to specify the 
number of columns and the default duration for each column.  You 
can also specify an audio/music file for the computer to play while 
the grid is running.  You can use the Audio Wizard to synchronize 
your lights to the beat of the music you have chosen. 
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Modifying a grid routine 
 
Once you have created a grid routine you can modify it so that 
individual lights turn on at precise times in the show.  When you 
look at a grid you will notice that the top row of the grid is the time 
when that column will ‘play’ during playback.  Also notice the 
labels of the lights and groups that you have created listed in the 
left-most column. 
 
By clicking areas inside the grid you can specify when certain 
lights or groups turn on and off.  You can drag the column 
separators to increase or shorten the length of time for a light 
sequence within a routine.  You also can manually set the time for 
each column by right clicking the column heading and selecting 
‘Change Column Time’. 
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Levels, Styles and Effects 
 
Using Animation Director™, you can modify how lights turn on 
and off and how long it takes for a light to turn on and off.  First 
you must set up the time for light to ramp and fade when different 
effects are used.  You must also specify the level that the lights 
will turn on to. 

• On Level:  Specifies the intensity level of the lights when 
turned on using an effect. 

• Ramp Rate:  Specifies the time it will take to turn on a light 
or group of lights to the chosen on level. 

• Fade Rate:  Specifies the time it will take to turn a light or 
group of lights off. 

 
Animation Director™ also gives you three different types of styles 
to use with you lighting show: set, fade, and add.  The “style” 
setting is used to control how lights that already on are affected 
when new lights are being turned on. 

• Style Set: This style turns off lights instantly that are not on 
in the following column. 

• Style Fade: This style turns off lights at the determined fade 
rate that are not on in the following column. 

• Style Add: This style adds lights to the lights that are 
already on from previous columns. 
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Animation Director™ gives you seven different types of effects to 
use with you lighting show: ramp, blink, pop fade, rev pop fade, 
sparkle, flicker, and shimmer.  Each of these effects have settings 
you can modify to tailor the appearance of the effect.  You can 
modify these setting by right clicking the column header of the 
column in which you would like a new effect to occur.  Different 
effects use different combinations of ramp, fade, and special rates. 

• Ramp:  The ramp effect turns on the on the output of the 
light controller to the specified on level.  The Ramp effect 
uses the ramp rate when turned on, and the fade rate when 
turned off. 

• Blink:  The blink effect turns on and off a light on the 
output of the light controller at a specified rate.  The Blink 
effect uses the ramp rate, fade rate, and blink rate. 

• Pop Fade:  The pop fade effect turns on the light or group 
of lights instantly then fades to off at the specified fade 
rate.  The Pop Fade effect uses the Pop Fade rate. 

• Rev(erse)-Pop Fade:  The rev-pop fade effect turns an 
already on light off instantly then ramps back to the on 
level.  The Rev-Pop Fade effect uses the rev-pop rate. 

• Sparkle:  When used with an individual light, the sparkle 
effect will pop fade the light at random times.  When used 
with a group, the sparkle effect will pop fade individual 
lights in a group at random times.  The Sparkle effect uses 
the sparkle rate. 

• Flicker:  The Flicker effect make the light or group of 
lights appear to look like a burning candle.  When used 
with groups the lights will flicker individually.  The Flicker 
effect uses the flicker rate. 

• Shimmer:  The Shimmer effect varies the intensity of the 
lights connected to the light controller.  When used with 
groups the shimmer effect the light will shimmer 
simultaneously.  The Shimmer effect uses the shimmer rate. 

 
When you change the style or effect of a column, all subsequent 
columns will use that style and effect until a new style and/or 
effect is defined along with set levels and rates. 
 
Columns that have been modified from default settings will be 
highlighted in yellow, indicating a change in brightness level, 
style, effect, or rate. 
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Once you have finished your grid routine you can test it by 
clicking the ‘Run-Live’ button.  If selected an audio/music file to 
be associated with the grid it should start playing as well. 
 
7) Lab: Create grid routines 
 
Grid One 

1. Create a grid routine 
2. Select what lights you want on and off 
3. Select Run-live and watch the outputs 

 
Grid Two 

1. Create a grid routine 
2. Select what lights you want on and off 
3. Select what effects you’d like to have in at least two 

different columns 
4. Select Run-live and watch the outputs 

 
Grid Three 

1. Create a grid routine, selecting an audio file to use with the 
grid 

2. Run the Audio Wizard to time the grid to the audio file 
3. Select what lights you want on and off 
4. Select Run-live and watch the outputs 
5. Convert grid to code by opening Routines and then 

selecting Change Grid to Source Code 
6. Examine code 
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Creating a code routine 
 
A code routine is another one of the methods used to program the 
Monster Brain™ by writing ACL code.  A new code routine can 
be created by selecting the Routines menu and then selecting ‘Add 
New Code Routine’. 
 
Animation Control Language (ACL) provides you with a 
comprehensive set of commands and functions to create a show 
from scratch and control every aspect of it along the way. 
 
Please review the material provided in the ACL Reference of the 
help system included with Animation Director™ is Help system 
and  refer to the examples to get a feel for how routines are 
constructed to provide the least amount of coding with the optimal 
affect. 
 
In general, as you construct your program: 
 
Define and declare variables and constants first. 
 
In each routine: 
 
Define the behavioral attributes first (such as the trio of level, rate, 
and effect for lights). 
 
Construct your control structure. 
 
Identify the target show component. 
 
Whenever you turn on a component, don't forget to also turn it off. 
 
Incorporate delays to establish activity lengths, time between 
activities in the routine, and time between routines. 
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8) LAB: Create code routines 
 
Code Routine 1 

1. Create a code routine 
2. Type in the following code in the code window: 
 
light.setonlevel(255) 
light.setrate(alrateramp, 0) 
light.setrate(alratefade, 0) 
light.setoneffect(aleffectramp) 
light.alloff 
 
Infinite 
 
Light.on(0) 
Delay_seconds(1) 
Light.off(0) 
Delay_seconds(1) 
 
3. Compile the routine 
4. Download the routine to the Monster Brain™ 
5. Click the Run button and watch the outputs 

 



 

Copyright© 2003 
Animated Lighting, L.C. 

All Rights Reserved Software Overview - 20 
 

Software 
Overview 

Code Routine 2 
1. Create a code routine 
2. Type in the following code in the code window: 
 
public t as integer 
 
light.setonlevel(255) 
light.setrate(alrateramp, 0) 
light.setrate(alratefade, 0) 
light.setoneffect(aleffectramp) 
light.alloff 
 
infinite 
 
For t=0 to 3 
  Light.on(t) 

Delay_seconds(0.3) 
Light.off(t) 
Delay_seconds(0.3) 

   Next t 
 
3. Compile the routine 
4. Download the routine to the Monster Brain™ 
5. Click the Run button and watch the outputs 
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Code Routine 3 
1. Create a code routine 
2. Type in the following code in the code window: 
 
public t as integer 
 
light.setonlevel(255) 
light.setrate(alrateramp, 0) 
light.setrate(alratefade, 0.4) 
light.setoneffect(aleffectramp) 
light.alloff 
 
infinite 
 
For t=0 to 7 
  Light.on(t) 

Delay_seconds(0.2) 
Light.off(t) 
Delay_seconds(0.2) 

   Next t 
 
3. Compile the routine 
4. Download the routine to the Monster Brain™ 
5. Click the Run button and watch the outputs 
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Programming the Monster Brain™ 
 
When you are ready to give the show a try you can program the 
Monster Brain™ with the show.  Do this by checking the boxes of 
all the routines you would like in your finished show and click the 
‘Compile’ button on the right side of the screen. 
 

 
 
Once the show compiles without any errors you can download it to 
any one of the 16 directories available.  Click the Download button 
on the right-side of the screen, select a directory, and then click 
download. 
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You may want to check the current time in the Monster Brain by 
clicking the ‘Get Date/Time from MB’ button on the Time/Date 

tab of the System window .  If the time and date are incorrect 
click the ‘Get Computer Time’ button and then the ‘Set 
Date/Time’ button to correct the situation. 
 
After downloading to the Monster Brain™, click the ‘Run’ button 
on the right side of the screen your show will start running. 
 
In case of a power outage you can set the ‘Auto-Run Flag’ so when 
power is restored your light show will run automatically.  If this 
flag is not set the Monster Brain™ will wait for a ‘Run’ command 
before it starts running the Startup routine (and hence your show). 
 
You can set the ‘Auto-Run flag’ by opening the ‘Tools’ menu and 
clicking on the ‘Set Auto-Run’ selection. 
 
NOTE: Time and Date information may be lost during a power 
outage unless a backup battery is used. 
 
 



 

Copyright© 2003 
Animated Lighting, L.C. 

All Rights Reserved Software Overview - 24 
 

Software 
Overview 

9) Typical programming cycle 
 
Once you have taken the initial steps of creating different routines 
you may find yourself in a cycle: 
 

• Note errors and fix them 
• Compile 
• Download 
• Run 
• Repeat until everything works as planned 

 
This is a normal part of creating shows and is to be expected.  As 
you work with the technology and gain experience creating shows 
this cycle will shorten considerably. 
 
 
10) Completing a project (start to finish) 
 
In summary, the steps a person would follow to complete a project 
from start to finish are: 
 
Pre-bid phase 

• View location of display and generate display ideas 
• Take measurements and create drawings 
• Calculate loads 
• Select your hardware and layout channels 
• Handle mounting issues 

 
Installation phase 

• Installation 
• Testing 
• Weather-proofing 

 
Software phase 

• Set-up and define channels 
• Group channels 
• Programming cycle 
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Set-up and Troubleshooting Guide 
 
General issues: 

• Hit Reset button on all LC's 
• Make sure RS-232/485 connections are in place 
• Check address switches 
• Be sure all controllers are plugged in 
• Reset all controllers 
• Check to see that the heartbeat LEDs on all of the 

controllers and the Monster Brain are blinking 
• Verify that all controllers are connected in a daisy chain 

fashion 
• Check to see that all controllers have unique addresses 
• Push the test button on the light controllers to verify that all 

connections are made properly and in order 
 
Enclosure issues: 

• Make sure that power is disconnected when making 
connections 

• Be sure that all connections are water proof to prevent 
shorts 

• Use a strain relief to prevent wires from being pulled out 
the bottom of the enclosure 

• After connecting lights to a controller, push the test button 
to see that lights are connected in order 

• You may need to drill a hole in the bottom of the enclosure 
to route network cables to multiple controllers 

 
If running a show: 

• Check to see that the Monster Brain’s Heartbeat LED (Red) 
and Run LED (Green) are blinking 

• Check to see if the light controllers are receiving 
commands (the green LED flashes on a light controller 
when a command is received) 

• If using a ‘Startup Routine’ be sure that the Monster 
Brain’s clock is set. 

• Make sure your trigger conditions are met. 
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Use the following chart for setting the address switches of your 
controllers (A1, A0) 
 
NOTE:  the LC-64 is considered to be four 16 channel light 
controllers so addressing will vary. 
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Occasionally there will be an update of Animated Lighting’s 
Software, Animation Director or Dasher Pro.  These updates are 
distributed to customers of Animated Lighting who have purchased 
Animation Director or Dasher Pro.  These updates are distributed 
for the purpose of adding features and fixes to Animated Lighting 
products and demonstrate Animated Lighting’s willingness to 
make their product more robust and easy to use. 
 
When installing a new version of Animation Director or Dasher 
Pro, it is recommended you update the firmware in your hardware 
to ensure proper operation.  By following the proper procedures 
below, your PC’s software and your hardware will all be updated. 
 
Installing Animation Director™ from CD: 

1. Insert the Animation Director™ CD into your PC. 
2. If an installation window doesn’t open automatically, start 

the installation by browsing for your CD-ROM drive, and 
double click the ‘SETUP.exe’ file. 

3. Follow the setup instructions to install the software. 
 
Installing Animation Director™ update from e-mail: 

1. Download the attachment from the update e-mail to a 
known location on your PC. 

2. Unzip the ‘disk1.zip’ file you downloaded. 
3. If an installation window doesn’t open automatically, start 

the installation by browsing for the ‘disk1’ folder you 
unzipped and double click the ‘SETUP.exe’ file. 

4. Follow the setup instructions to install the software. 
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Appendix D Updating the firmware on your Monster Brain™: 
1. Connect the PC to the Monster Brain™ using a DB9 serial 

cable. 
2. Apply power to the Monster Brain™. 
3. Start Animation Director™. 
4. Click the ‘System’ button on the Animation Director™ 

desktop. 
5. In the ‘System’ window, under the ‘Setup’ tab, select 

which COM port you use to connect to the Monster 
Brain™.  Also check the box next to ‘Communicate 
Through Monster Brain.’ 

6. In the ‘System’ window, under the ‘Firmware’ tab, click 
‘Browse’ to find the firmware file for the Monster Brain™.  
(MonsterBrain.ehx)  It will be located where you installed 
Animation Director™.  If you installed Animation 
Director™ to the default location it will be in: “C:\Program 
Files\Animated Lighting\Animation Director\Firmware.” 

7. Once you have located the correct file, MonsterBrain.ehx, 
click ‘Open’ to load the file. 

8. Click ‘Download’ to update the firmware in the MB.  You 
should see numbers cycling verifying new firmware is 
being downloaded.  The Monster Brain’s LEDs will also be 
flickering indicating it is receiving the new firmware. 

9. If the firmware was loaded correctly the Monster Brain’s 
Heartbeat LED will blink.  If there is an error, make sure 
the above steps were performed correctly. 
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Appendix D Updating the firmware in your Light Controller using a 
Monster Brain™: 

1. Connect the PC to the Monster Brain™ using a DB9 serial 
cable. 

2. Connect the Monster Brain™ to the Light Controller using 
a CAT5 cable. 

3. Apply power to the Monster Brain™ and the Light 
Controller. 

4. Start Animation Director™. 
5. Click the ‘System’ button on the Animation Director™ 

Desktop. 
6. In the ‘System’ window, under the ‘Setup’ tab, select 

which COM port you use to connect to the Monster 
Brain™.  Also check the box next to ‘Communicate 
Through Monster Brain.’ 

7. In the ‘System’ window, under the ‘Version’ tab, click ‘Get 
Info’ to verify communication with the Monster Brain™.  
If version information is not returned, check for proper 
connection with the PC and the Monster Brain™ and that 
the Monster Brain™ is running current firmware. 

8. Close the ‘System’ window. 
9. Click the ‘Lights’ button on the Animation Director™ 

Desktop. 
10. In the ‘Define Lights’ window under the ‘Controllers’ tab, 

check the addresses of the controllers you have connected 
in your system. 

11. In the ‘Define Lights’ window under the ‘Firmware’ tab, 
click ‘Browse’ to find the firmware file for you light 
controller(s).  (LC16-xxx.ehx, where xxx is the version 
number of the firmware, for example: LC16-500.ehx)  It 
will be located where you installed Animation Director™.  
If you installed Animation Director™ to the default 
location it will be in: “C:\Program Files\Animated 
Lighting\Animation Director\Firmware.” 

12. Once you have located the correct file, LC16-xxx.ehx, click 
‘Open’ to load the file. 

13. In the ‘Define Lights’ window under the ‘Firmware’ tab, 
check the addresses of the Light Controller(s) to be 
updated. 

14. Click ‘Download’ to update the firmware in your Light 
Controller(s).  You should see numbers cycling verifying 
new firmware is being downloaded.  The Light Controller’s 
LEDs will also be flickering indicating it is receiving the 
new firmware. 
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15. If the firmware was loaded correctly the Light Controller’s 

Heartbeat LED will blink.  If there is an error, make sure 
the above steps were performed correctly. 

 
Updating the firmware in your Light Controller without using 
a Monster Brain™: 

1. Connect the Light Controller to the PC using the DB9 serial 
cable. 

2. If using a CONV-1, RS-232 to RS-485 serial converter, 
connect the PC to the CONV-1 using a DB9 serial cable.  
Connect the CONV-1 to the Light Controller(s) using a 
CAT5 cable. 

3. Apply power to the Light Controller and the CONV-1, if 
using a serial converter. 

4. Start Animation Director™. 
5. Click the ‘System’ button on the Animation Director™ 

Desktop. 
6. In the ‘System’ window, under the ‘Setup’ tab, select 

which COM port you use to connect to the Light 
Controller.  Also un-check the box next to ‘Communicate 
Through Monster Brain.’ 

7. Click the ‘Lights’ button on the Animation Director™ 
Desktop. 

8. In the ‘Define Lights’ window under the ‘Controllers’ tab, 
check the addresses of the controllers you have connected 
in your system. 

9. In the ‘Define Lights’ window under the ‘Firmware’ tab, 
click ‘Browse’ to find the firmware file for you light 
controller(s).  (LC16-xxx.ehx, where xxx is the version 
number of the firmware, for example: LC16-500.ehx)  It 
will be located where you installed Animation Director™.  
If you installed Animation Director™ to the default 
location it will be in: “C:\Program Files\Animated 
Lighting\Animation Director\Firmware.” 

10. Once you have located the correct file, LC16-xxx.ehx, click 
‘Open’ to load the file. 

11. In the ‘Define Lights’ window under the ‘Firmware’ tab, 
check the addresses of the Light Controller(s) to be 
updated. 

12. Click ‘Download’ to update the firmware in your Light 
Controller(s).  You should see numbers cycling verifying 
new firmware is being downloaded.  The Light Controller’s 
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Appendix D LEDs will also be flickering indicating it is receiving the new 
firmware. 
13. If the firmware was loaded correctly the Light Controller’s 

Heartbeat LED will blink.  If there is an error, make sure 
the above steps were performed correctly. 

 
 


